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Op de achterkaft

Leer hoe u fraaie Flash-projecten met geavanceerde animaties ontwerpt, video en geluid
importeert, interactieve knoppen of animaties maakt en de Flash-mogelijkheden uitbreidt met
ActionScript 3.0. Met krachtige vernieuwde functies als Text Layout Format, het gereedschap Deco
en de afspeelmogelijkheid voor externe video kunt u nog sneller en gemakkelijker Flash-sites
ontwerpen.

De snelste en meest complete manier om te leren werken met Adobe Flash Professional CS5
Met Classroom in a Book, de succesvolle serie met praktijkgerichte werkboeken voor
softwaretraining, krijgt u de functies van Adobesoftware snel onder de knie. Classroom in a Book
biedt wat geen enkel ander boek of trainingsprogramma biedt: een officiële serie trainingen
ontwikkeld door experts bij Adobe zelf.

Adobe Flash CSS Classroom in a Book behandelt in tien lessen de belangrijkste mogelijkheden
van Flash, de populairste omgeving voor het maken van rijke, interactieve webcontent. U leert
bijvoorbeeld hoe u animaties maakt, omgaat met statische en dynamische tekst, werkt met de
tijdlijn en video of geluid importeert. Dankzij talloze tips, bijdragen van experts en aansprekende
voorbeelden wordt u een productieve en ervaren gebruiker van Flash. U kunt het boek van begin
tot eind doorwerken of alleen die lessen lezen waarin u geïnteresseerd bent. Voor gebruikers van
de Engelse versie is achter in het boek een handige woordenlijst opgenomen.

Inclusief dvd met lesbestanden.

De software Adobe Flash Professional CS5 is niet inbegrepen bij dit boek.
“De serie Classroom in Book is verreweg het beste trainingsmateriaal dat er is. De boeken
bevatten alles wat je nodig hebt om met de software te leren omgaan: heldere uitleg bij elke les,
stap-voor-stap instructies en oefenbestanden.”
Barbara Binder, Adobe Certified Expert
ISBN 978 90 430 2095 4

Aan de slag
Adobe Flash Professional CS5 biedt een volledige ontwikkelomgeving voor het creëren van digitale
animaties en interactieve websites. Flash wordt vaak ingezet voor het maken van aantrekkelijke
toepassingen die uitvoerig gebruikmaken van video, afbeeldingen en animaties. U kunt content in
Flash creëren of deze importeren uit andere Adobe-toepassingen zoals Photoshop of Illustrator. U
kunt in korte tijd eenvoudige animaties ontwerpen, maar ook complexe interactieve projecten
ontwikkelen met behulp van Adobe ActionScript 3.0.







Wanneer u aan een les begint, navigeert u naar de map met het betreffende lesnummer, waar u
alle noodzakelijke bestanden, voorbeeldfilms en andere projectbestanden aantreft die u nodig hebt
om de les te voltooien.

Als u maar beperkte opslagruimte hebt op uw computer, kunt u een gekopieerde les desgewenst
weer wissen van de harde schijf nadat u met de les klaar bent. Sommige lessen bouwen voort op
een voorafgaande les: in dit geval bevat de vervolgles altijd een bijgewerkt projectbestand. U hoeft
dus geen voltooide projecten op te slaan als u dat niet wilt of als u maar beperkte schijfruimte ter
beschikking hebt.

Voorbeeldfilms en projecten kopiëren
In sommige lessen zult u swf-bestanden (animaties) maken en publiceren. De bestanden in de
mappen End (01End, 02End enzovoort) binnen de mappen Lessons zijn voorbeelden van de
voltooide projecten voor elke les. Gebruik deze bestanden als referentie als u uw onvoltooide werk
wilt vergelijken met de projectbestanden waarmee de voorbeeldfilms zijn gemaakt. De voltooide
projectbestanden variëren in omvang van relatief klein tot enkele megabytes, dus kunt u ze nu al
allemaal kopiëren als u genoeg ruimte hebt, of alleen het voltooide projectbestand voor de les waar
u mee bezig bent. Na afloop van de les kunt u dat bestand weer wissen.

Hoe gebruikt u deze lessen?
Elke les in dit boek voorziet in stapsgewijze instructies voor het maken van een of meer specifieke
elementen van een echt project. Sommige lessen bouwen voort op projecten die in eerdere lessen
zijn gemaakt, maar de meeste lessen staan op zichzelf. Alle lessen bouwen op elkaar voort als het
gaat om concepten en vaardigheden, zodat u er verstandig aan doet de lessen in de bestaande
volgorde door te nemen. Sommige technieken en processen worden in dit boek alleen de eerste
keren dat ze gebruikt worden in detail uitgelegd en beschreven.

De organisatie van de lessen is gericht op het project en niet op programmafuncties. Dit betekent
bijvoorbeeld dat u in meerdere lessen aan ontwerpprojecten zult werken met symbolen, in plaats
van in maar één hoofdstuk.

Opmerking: veel aspecten van het programma kunnen met meerdere technieken worden uitge-
voerd, zoals een menuopdracht, een knop, slepen en een sneltoets. Per procedure worden steeds
maar een of twee technieken beschreven, zodat u op verschillende manieren leert werken, ook als
u de taak al eens eerder hebt uitgevoerd.

Extra hulpmiddelen
Adobe Flash CS5 Classroom in a Book is niet bedoeld als vervanging voor de documentatie die bij
het programma wordt geleverd of als omvattend naslagwerk voor elke voorziening. Het boek legt
alleen de opdrachten en opties uit die daadwerkelijk in de lessen gebruikt worden, dus blijft er nog
genoeg te leren over. Zie voor uitgebreidere informatie over de programmafuncties en tutorials:

Adobe Community Help: Community Help is een platform waarmee actieve gebruikers van
Adobe-producten, leden van Adobe-productteams, auteurs en experts elkaar kunnen ontmoeten
en nuttige, relevante en actuele informatie over Adobe-producten kunnen uitwisselen. Als u op
zoek bent naar een codevoorbeeld of een oplossing voor probleem, een vraag over de software







Adobe CS Review is voor creatieve professionals die een nieuw niveau van efficiëntie in het
creatieve revisieproces willen. Anders dan andere services die online revisie van creatieve inhoud
bieden, biedt alleen CS Review de mogelijkheid rechtstreeks vanuit InDesign, Photoshop,
Photoshop Extended en Illustrator een revisie op het web te posten en revisieopmerkingen in de
oorspronkelijke Creative Suite-toepassing te bekijken.

Acrobat.com is voor creatieve professionals die samen met een groep collega’s en klanten aan
een creatief project moeten werken vanaf de creatieve instructies tot aan het uiteindelijke product.
Acrobat.com is een reeks online services met mogelijkheden voor webvergaderingen, online
bestandsdeling en werkruimten. Anders dan samenwerken via e-mail en het persoonlijk bijwonen
van vergaderingen, kunt u tijd besparen want in plaats van bestanden naar mensen te sturen
brengt Acrobat.com mensen naar uw werk, waardoor u de zakelijke kant van het creatieve proces
sneller, samen met anderen en vanaf elke locatie kunt uitvoeren.

Adobe Story is voor creatieve professionals, producenten en schrijvers die aan of met scripts
werken. Story is een hulpprogramma voor samenwerking aan script-ontwikkeling dat scripts omzet
in metadata die kunnen worden gebruikt met de hulpprogramma’s van Adobe CS5 Production
Premium om werkschema’s te stroomlijnen en video te produceren.

SiteCatalyst NetAverages is voor web- en mobielprofessionals die hun projecten willen optimaliseren
voor een breder publiek. NetAverages biedt informatie over hoe gebruikers toegang tot het web
verkrijgen, waardoor het giswerk vroeg in het creatieve proces wordt gereduceerd. U hebt toegang tot
gecombineerde gebruikersgegevens zoals type browser, besturingssysteem, mobiel-apparaatprofiel,
schermresolutie enzovoort, die over een periode kunnen worden weergegeven. De gegevens worden
verkregen van bezoekersactiviteit op websites die gebruik maken van Omniture SiteCatalyst. Anders
dan andere oplossingen voor webinformatie, geeft NetAverages de gegevens weer met Flash,
waardoor een robuuste doch eenvoudig te volgen beleving wordt gecreëerd.

CS Live is op drie verschillende manieren toegankelijk:
1 Stel toegang in wanneer u uw Creative Suite 5-producten registreert, u hebt dan gratis toegang

tot alle functie- en werkschemavoordelen van het gebruik van CS Live met CS5.
2 Stel toegang in door online lid te worden om een beperkte periode toegang tot CS Live-services

te verkrijgen. Met deze optie hebt u geen toegang tot de services vanuit uw producten.
3 Producttestversies voor computers bevatten een testversie van CS Live-services die 30 dagen

geldig is.





3 Sluit het voorbeeldvenster.
4 Kies Bestand > Nieuw. Kies in het dialoogvenster Nieuw document ActionScript 3.0. Klik op OK.

ActionScript 3.0 is de recentste versie van de scripttaal van Flash, waarmee u interactiviteit kunt
toevoegen. Voor ActionScript 3.0 is vereist dat uw browser over Flash Player 9 of hoger
beschikt. In deze les werkt u niet met ActionScript, maar u dient al wel aan te geven met welke
versie het nieuwe bestand compatibel is.

5 Kies Bestand > Opslaan als. Noem het bestand O1_werkkopie.fla en kies Flash CS5-document
(*.fla) uit het menu. Sla het op in de map 01Start. Het is een goede gewoonte het bestand
onmiddellijk op te slaan. U voorkomt ermee dat uw werk verloren gaat als de toepassing of de
computer onverhoopt vastloopt. Sla uw Flash-bestand altijd op met de extensie .fla om het te
identificeren als een Flash-bronbestand.

De werkruimte verkennen
Tot de werkruimte van Adobe Flash Professional behoren de opdrachtmenu’s boven in het scherm
en verscheidene gereedschappen en deelvensters om elementen mee te bewerken en aan uw film
toe te voegen. U kunt alle objecten voor uw animatie in Flash zelf creëren, maar u kunt ook
elementen importeren die u gemaakt hebt in Adobe Illustrator, Adobe Photoshop, Adobe After
Effects en andere vergelijkbare toepassingen.

Standaard verschijnen de menubalk, de tijdlijn, het werkgebied, het deelvenster Gereedschappen,
Eigenschapcontrole en enkele andere deelvensters. Tijdens het werken in Flash kunt u naar
gelang uw beeldschermresolutie of voorkeur deelvensters openen, sluiten, dokken, ontdokken en
op een andere positie op het scherm neerzetten.

Een nieuwe werkruimte kiezen
In Flash zitten ook een aantal rangschikkingen van de deelvensters ingebouwd om specifieke
gebruikers tegemoet te komen. De verschillende werkruimtes staan in het menu rechtsboven in het
scherm en onder het menu Venster > Werkruimte.



1 Klik op de knop Hoofdpunten rechtsboven in het scherm en kies
een nieuwe werkruimte. De verschillende deelvensers worden
opnieuw gerangschikt voor de specifieke gebruiker. Bij de
werkruimte voor de Animator en de Ontwerper staat de tijdlijn bij-
voorbeeld bovenaan zodat hij makkelijk bereikbaar is.

2 Als u een of meer deelvensters verplaatst hebt en u wilt terug naar
de voorinstelling, kies dan Venster > Werkruimte > ... opnieuw
instellen.

3 Om terug te gaan naar de standaardwerkruimte kiest u Venster >
Werkruimte > Hoofdpunten. In dit boek gebruiken we de
werkruimte Hoofdpunten.

Een werkruimte opslaan
Vindt u een bepaalde rangschikking van deelvensters prettig dan kunt u
die opslaan als werkruimte zodat u haar later weer op kunt roepen.

1 Klik op de knop met de naam van de huidige werkruimte rechtsboven
in het scherm en klik op Nieuwe werkruimte.
Het dialoogvenster Nieuwe werkruimte verschijnt.

2 Geef een naam op voor de nieuwe werkruimte en klik op OK.
De huidige rangschikking is nu opgeslagen. Uw werkruimte is
toegevoegd aan de lijst in het menu zodat u snel terug kunt naar
deze rangschikking.

Het werkgebied
De grote witte rechthoek in het midden van uw scherm wordt het
werkgebied genoemd. Net als bij het toneel in een theater, is in
Flash het werkgebied de plek die de kijker ziet wanneer een film wordt afgespeeld. Het bevat de
tekst, afbeeldingen en video die op het scherm verschijnen. Beweeg elementen op en van het
werkgebied om ze in of buiten beeld te plaatsen. U kunt linialen (Weergave > Linialen) of rasters
(Weergave > Raster > Raster weergeven) gebruiken om items heel precies in het werkgebied te
positioneren. Daarnaast kunt u het deelvenster Uitlijnen en andere gereedschappen gebruiken die
u in de lessen in dit boek leert toepassen.

Standaard ziet u rond het werkgebied een grijs gebied waar u elementen kunt plaatsen die niet
zichtbaar zullen zijn voor de toeschouwers. Het grijze gebied
wordt het plakbord genoemd Als u alleen het werkgebied wilt
zien, kiest u Weergave > Plakbord om deze optie uit te
schakelen. Voor nu laten we de optie ingeschakeld.

Kies Weergave > Vergroting > Passend in venster om het
hele werkgebied volledig in het programmavenster weer te
geven. U kunt ook een weergaveoptie kiezen in het menu
rechtsboven het werkgebied.

De werkgebiedeigenschappen aanpassen
Allereerst gaan we de kleur en afmetingen van het werkgebied bepalen. Deze opties zijn
beschikbaar in Eigenschapcontrole, het verticale deelvenster aan de rechterkant van het werk-
gebied.



1 Merk op dat onder in het deelvenster Eigenschappen de afmetingen
van het huidige werkgebied zijn ingesteld op 550 x 400 pixels. Klik op
de knop Bewerken.
Het dialoogvenster Documentinstellingen verschijnt.

2 Geef in de vakken Breedte en Hoogte nieuwe afmetingen op in pixels.
Geef 800 op voor de breedte en 600 voor de hoogte.

3 Klik op het vak Achtergrondkleur en kies een nieuwe kleur voor het werkgebied. Kies donkergrijs
(#333333).

4 Klik op OK. Uw werkgebied heeft nu andere afmetingen en een andere kleur. U kunt de kleur
van het werkgebied ook wijzigen door in Eigenschapcontrole op de knop Werkgebied te klikken.
U kunt de werkgebiedeigenschappen op elk gewenst moment wijzigen.

Werken met het deelvenster Bibliotheek
Het deelvenster Bibliotheek is toegankelijk via een tab direct naast de tab Eigenschappen. Het is
de plek waar u in Flash gemaakte symbolen opslaat en beheert. Hetzelfde geldt voor geïm-
porteerde bestanden, zoals bitmaps, afbeeldingen, geluidsbestanden en videoclips. Symbolen zijn
veelgebruikte afbeeldingen voor animatie en interactiviteit.

Opmerking: in les 3 leert u meer over symbolen.

Het deelvenster Bibliotheek
Met het deelvenster Bibliotheek kunt u bibliotheekitems in mappen onderbrengen, zien hoe vaak
een item in een document is gebruikt en items op type sorteren. U kunt items in Flash importeren in
het werkgebied of in de bibliotheek. Elk item dat u in het werkgebied importeert, wordt automatisch
toegevoegd aan de bibliotheek en hetzelfde geldt voor alle symbolen die u maakt. Zo hebt u
gemakkelijk toegang tot de items om ze later weer aan het werkgebied toe te voegen, te bewerken
of de eigenschappen ervan te bekijken.

Om de bibliotheek weer te geven, kiest u Venster > Bibliotheek, of
gebruikt u de toetsencombinatie Ctrl+L (Windows) of Command+L
(Mac).

Een item importeren in het deelvenster Bibliotheek
Vaak zult u afbeeldingen direct met de tekengereedschappen van
Flash creëren en opslaan als symbolen, die worden ondergebracht
in de Bibliotheek. Soms zult u media als JPEG-afbeeldingen of mp3-
geluidsbestanden importeren, die eveneens in de bibliotheek
worden opgeslagen. In deze les gaat u verscheidene JPEG-
afbeeldingen importeren in de bibliotheek om deze later te
gebruiken in de animatie.



1 Kies Bestand > Importeren > Importeren in bibliotheek. Selecteer in het dialoogvenster Openen
het bestand background.jpg in de map Lesson01\01Start en klik op Openen.

2 Flash importeert de geselecteerde afbeelding en plaatst deze in het deelvenster Bibliotheek.
3 Importeer ook photol.jpg, photo2.jpg en photo3.jpg uit de map 01Start. Importeer photo4.jpg

niet; die wordt later in deze les gebruikt.
U kunt de Shift-toets ingedrukt houden om meerdere bestanden te selecteren en ze allemaal in
een keer te importeren.

4 Het deelvenster Bibliotheek laat alle geïmporteerde JPEG-afbeeldingen zien met hun
bestandsnamen en een thumbnail (miniatuurweergave). Deze afbeeldingen zijn nu beschikbaar
om in uw Flash-document te worden gebruikt.

Een item uit het deelvenster Bibliotheek toevoegen
Om een bibliotheekitem aan een Flash-document toe te voegen, sleept u het item simpelweg van
het deelvenster Bibliotheek in het werkgebied.

1 Kies Venster > Bibliotheek om het deelvenster Bibliotheek te openen (als het nog niet is
geopend).

2 Selecteer het item background.jpg in het deelvenster Bibliotheek.
3 Sleep het item background.jpg in het werkgebied en plaats het ongeveer in het midden ervan.

De tijdlijn
De tijdlijn bevindt zich onder het werkgebied. Net als bij films delen Flash-documenten de tijd op
met behulp van frames. Terwijl de film wordt afgespeeld, beweegt de afspeelkop zich door de
frames in de tijdlijn. U kunt de inhoud van de frames wijzigen in het werkgebied. U laat de inhoud
van een frame in het werkgebied verschijnen door de afspeelkop naar het gewenste frame in de
tijdlijn te slepen.

Onder aan de tijdlijn toont Flash het geselecteerde framenummer, de huidige framerate (het aantal
afgespeelde frames per seconde) en de verstreken speeltijd tot dan toe.

De tijdlijn bevat ook lagen waarmee u de elementen in uw document kunt rangschikken. U kunt
lagen zien als meerdere stroken film die op elkaar zijn gelegd. Elke laag bevat een andere
afbeelding die in het werkgebied verschijnt. U kunt objecten op de ene laag tekenen en bewerken
zonder dat dit gevolgen heeft voor objecten op andere lagen. De lagen zijn gestapeld in de
volgorde waarin ze elkaar overlappen, zodat objecten op de onderste laag van de tijdlijn zich onder



op de stapel in het werkgebied bevinden. U kunt lagen verbergen,
weergeven, vergrendelen en ontgrendelen. De frames van elke laag zijn
uniek, maar u kunt ze naar een andere locatie op dezelfde laag slepen
of naar een andere laag kopiëren of verplaatsen.

Een laag een andere naam geven
Het is verstandig elke laag een naam te geven die de inhoud ervan beschrijft, zodat u de gewenste
laag later gemakkelijk terug kunt vinden.

1 Selecteer de bestaande laag in de tijdlijn.
2 Dubbelklik op de naam van de laag om deze een andere naam te geven en typ background.
3 Klik buiten het naamvak en pas de nieuwe naam toe.

4 Klik op de zwarte stip onder het hang-
slotpictogram om de laag te vergrendelen.
Daarmee voorkomt u dat u per ongeluk
wijzigingen aanbrengt in de laag.

Een laag toevoegen
Een nieuw Flash-document bevat maar één laag,
maar u kunt zoveel lagen toevoegen als u
wilt. Objecten in de bovenliggende lagen zullen
objecten in lagergelegen lagen overlappen.

1 Selecteer de achtergrondlaag in de tijdlijn.
2 Kies Invoegen > Tijdlijn > Laag. U kunt ook

onder de tijdlijn op de knop Nieuwe laag klikken.
Er verschijnt een nieuwe laag boven de
achtergrondlaag.

3 Dubbelklik op de nieuwe laag om deze een
andere naam te geven en typ photol. Klik ergens
naast het naamveld om de nieuwe naam toe te
passen.
De tijdlijn heeft nu twee lagen. De achtergrond-
laag bevat de achtergrondfoto en de daarboven
gelegen laag photol is leeg.

4 Selecteer de bovenste laag (photo1).
5 Kies Venster > Bibliotheek om (zo nodig) het

deelvenster Bibliotheek te openen.
6 Sleep het bibliotheekitem photol.jpg uit de

bibliotheek op het werkgebied.



Het bestand photol.jpg verschijnt in het werkgebied en overlapt de achtergrondafbeelding.
7 Kies Invoegen > Tijdlijn > Laag of klik onder de tijdlijn op de knop Nieuwe laag ( ) om een derde laag

toe te voegen.
8 Noem de derde laag photo2.

Werken met lagen
Als u van een laag af wilt, kunt u die eenvoudig verwijderen door deze te selecteren en onder de
tijdlijn op de knop Verwijderen te klikken.

Als u de lagen wilt herschikken, klikt u simpelweg op een laag en sleept u die naar een nieuwe
positie in de stapel.

Frames invoegen
Tot dusverre hebt u op het werkgebied een achtergrondfoto en een andere, overlappende foto
staan, maar uw hele animatie bestaat slechts uit één enkel frame. Om meer tijd te creëren in de
tijdlijn, dient u extra frames toe te voegen.

1 Selecteer frame 48 in de achtergrondlaag (background).

2 Kies Invoegen > Tijdlijn > Frame (F5). Met de rechtermuisknop (Windows) of met Ctrl+klik (Mac)
kunt u ook in het snelmenu de optie Frame invoegen kiezen.
Flash voegt in de achtergrondlaag frames toe tot aan het geselecteerde punt (frame 48).

3 Selecteer frame 48 in de laag photol.
4 Kies Invoegen > Tijdlijn > Frame (F5). Met de rechtermuisknop (Windows) of met Ctrl+klik (Mac

OS) kunt u ook in het snelmenu de optie Frame invoegen kiezen.
Flash voegt in de laag photol frames toe tot aan het geselecteerde punt (frame 48).



5 Selecteer frame 48 in de laag photo2 en voeg frames toe aan deze laag.
U hebt nu 3 lagen met elk 48 frames in de tijdlijn. Aangezien de framerate van uw Flash-docu-
ment 24 frames per seconde is, duurt uw animatie twee seconden.

Meerdere frames tegelijk selecteren
Net zoals u met ingedrukte Shift-toets meerdere bestanden ineens kunt selecteren op uw desktop,
kunt u op dezelfde manier in de tijdlijn meerdere frames tegelijk selecteren. Als u verschillende
lagen hebt en op elke laag frames wilt invoegen, houd u de Shift-toets ingedrukt en klikt u op het
punt waarop u in alle lagen frames wilt invoegen. Kies vervolgens Invoegen > Tijdlijn > Frame.

Een hoofdframe maken
Een hoofdframe geeft aan dat er iets verandert aan de inhoud in het werkgebied. Hoofdframes
worden in de tijdlijn aangeduid met een klein cirkeltje. Een lege cirkel betekent dat er zich op die
plek in die laag momenteel niets bevindt. Een opgevulde zwarte cirkel betekent dat er zich op die
plek in die laag momenteel wel iets bevindt. Zo bevat bijvoorbeeld de achtergrondlaag een gevuld
hoofdframe (zwarte cirkel) in zijn eerste frame. De laag photol bevat eveneens een gevuld
hoofdframe in zijn eerste frame. Beide lagen bevatten foto’s. De laag photo2 daarentegen bevat
een leeg hoofdframe in zijn eerste frame, ten teken dat het momenteel leeg is.

U gaat een hoofdframe invoegen in de laag photo2 op het tijdstip waarop u de volgende foto wilt
laten verschijnen.
1 Selecteer frame 24 op de laag photo2. Als u een frame selecteert, geeft Flash onder de tijdlijn

het bijbehorende framenummer weer.

2 Kies Invoegen > Tijdlijn > Hoofdframe (F6).
Er verschijnt een nieuw hoofdframe, aangegeven met een lege cirkel, in frame 24 van de laag
photo2.



3 Selecteer het nieuwe hoofdframe in frame 24 van de
laag photo2.

4 Sleep het item photo2.jpg vanuit de bibliotheek op het
werkgebied.
De lege cirkel in frame 24 wordt nu gevuld, om aan te
geven dat er een verandering heeft plaatsgevonden in
de laag photo2. Bij frame 24 verschijnt de foto in het
werkgebied. U kunt de rode afspeelkop boven in de
tijdlijn verslepen om te zien wat er zich op een bepaald
punt in de tijdlijn afspeelt in het werkgebied.

U zult zien dat de achtergrondfoto en photol de hele
tijdlijn in het werkgebied aanwezig blijven, terwijl photo2
pas verschijnt bij frame 24.

Een goed begrip van frames en hoofdframes is essentieel om Flash onder de knie te krijgen. Zorg
dat u begrijpt dat de laag photo2 48 frames bevat met 2 hoofdframes - een leeg hoofdframe bij
frame 1 en een gevuld hoofdframe bij frame 24.

Een hoofdframe verplaatsen
Als u photo2.jpg eerder of later wilt laten verschijnen, moet u het hoofdframe waarin de foto
verschijnt verplaatsen naar een andere plek in de tijdlijn. U kunt een hoofdframe eenvoudig
verplaatsen door het te selecteren en naar een nieuwe positie in de tijdlijn te slepen.

1 Selecteer het hoofdframe in frame 24 op de laag photo2.
2 Verplaats de muisaanwijzer een klein stukje. U ziet naast de muisaanwijzer een rechthoekje

verschijnen om aan te geven dat u het hoofdframe nu kunt verplaatsen.
3 Klik op het hoofdframe en sleep het naar frame 12 in de laag photo2.

Photo2.jpg verschijnt nu veel eerder in de animatie in het werkgebied.

Hoofdframes verwijderen
Druk niet op de Del-toets als u een hoofdframe wilt verwijderen! Daarmee wist u namelijk de
inhoud van dat hoofdframe in het werkgebied. Selecteer in plaats daarvan het hoofdframe en kies
Wijzigen > Tijdlijn > Hoofdframe verwijderen (Shift+F6). Het hoofdframe wordt dan verwijderd uit de
tijdlijn.



Lagen in een tijdlijn organiseren
Op het moment heeft uw werkbestand slechts drie lagen: een achtergrondlaag, een laag photol en
een laag photo2. U gaat voor dit project extra lagen toevoegen zodat u, zoals bij de meeste
projecten, meerdere lagen moet gaan beheren. Met laagmappen kunt u verwante lagen groeperen
om de tijdlijn op orde en beheersbaar te houden. Het is vergelijkbaar met het onderbrengen van
verwante documenten in mappen op uw desktop. Hoewel het enige tijd vergt om de mappen te
maken, bespaart u er later tijd mee omdat u precies weet waar u een specifieke laag kunt vinden.

Laagmappen maken
Voor dit project gaat u verder met het toevoegen van lagen voor extra foto’s en gaat u die lagen in
een laagmap plaatsen.

1 Selecteer de laag photo2 en klik op de knop Nieuwe laag (l).
2 Noem de laag photo3.
3 Voeg een hoofdframe in bij frame 24.
4 Sleep photo3.jpg vanuit de bibliotheek op het werkgebied.

U hebt nu vier lagen. De bovenste drie bevatten foto’s van Coney Island die bij verschillende
hoofdframes verschijnen.

5 electeer de laag photo3 en klik op het pictogram Nieuwe map (i). Er verschijnt een nieuwe
laagmap boven de laag photo3.

6 Noem de map photos.



Lagen toevoegen aan laagmappen
U gaat nu de fotolagen toevoegen aan de fotomap. Denk er bij het ordenen van lagen aan dat
Flash de lagen weergeeft in de volgorde waarin ze verschijnen in de tijdlijn, waarbij de bovenste
laag op de voorgrond staat en de onderste laag op de achtergrond.

1 Sleep de laag photol op de fotomap.
Merk op dat de vette lijn de bestemming van de laag aangeeft. Wanneer een laag binnen een
map wordt geplaatst, wordt de laagnaam ingesprongen weergegeven.

2 Sleep de laag photo2 op de fotomap.
3 Sleep de laag photo3 op de fotomap.

Alle drie de fotolagen dienen zich nu in de fotomap te bevinden.

U kunt de map samenvouwen door op het neerwaartse pijltje te klikken. Vouw de map uit door
opnieuw op het pijltje te klikken. Bedenk dat als u een laagmap wist, u tevens alle lagen in die
map verwijdert.

Het uiterlijk van de tijdlijn aanpassen
U kunt het uiterlijk van de tijdlijn desgewenst aanpassen. Als u meer lagen
wilt zien, selecteert u Kort in het uitklapmenu in de rechterbovenhoek van
de tijdlijn. De optie Kort verlaagt de hoogte van de framecelrijen. Met de
opties Voorvertoning en Voorvertoning in context ziet u voorvertoningen
van de inhoud van de hoofdframes in de tijdlijn.

Ook kunt u de breedte van de framecellen aanpassen met de opties Zeer
klein, Klein, Normaal, Middelgroot of Groot.

Eigenschapcontrole gebruiken
Met Eigenschapcontrole (het deelvenster Eigenschappen) hebt u snel toegang tot de attributen die
u het meest waarschijnlijk nodig hebt. Wat er in Eigenschapcontrole verschijnt, is afhankelijk van
wat u hebt geselecteerd. Als er bijvoorbeeld niets is geselecteerd, bevat

Eigenschapcontrole algemene opties voor het Flash-document, waaronder het wijzigen van de
kleur en de afmetingen van het werkgebied; als een object in het werkgebied is geselecteerd, laat
Eigenschapcontrole de bijbehorende x- en y-coordinaten en de breedte, hoogte en andere
eigenschappen van het object zien. U gaat Eigenschapcontrole gebruiken om uw foto’s in het
werkgebied te verplaatsen.



Een object positioneren in het werkgebied
Allereerst verplaatst u de foto’s met behulp van Eigenschapcontrole. Daarna gebruikt u het
deelvenster Transformeren om de foto’s te roteren.

1 Selecteer in frame 1 van de tijdlijn de afbeelding photol.jpg die u in het werkgebied hebt
gesleept in de laag photo1. Een blauwe omtrek geeft aan dat het object is geselecteerd.

2 Typ in Eigenschapcontrole 50 voor de waarde X en 50 voor de waarde Y. Druk op Enter of
Return om de waarden toe te passen. U kunt ook met de muisaanwijzer over de X- en Y-
waarden slepen om hun positie te veranderen. De foto komt links van het werkgebied te staan.

Opmerking: als Eigenschapcontrole niet is geopend, kiest u Venster > Eigenschappen, of gebruikt
u de toetsencombinatie Ctrl/Command+F3.

De X- en Y-waarden worden in het werkgebied gemeten vanaf de linkerbovenhoek. X begint bij 0
en loopt op naar rechts, Y begint bij 0 en loopt op naar beneden. Het registratiepunt voor
geïmporteerde foto’s bevindt zich in de linkerbovenhoek.

3 Kies Venster > Transformeren om het deelvenster Transformeren te openen.
4 Selecteer Roteren in het deelvenster Transformeren en typ -12 in het vak Roteren of klik en sleep

over de waarde om de rotatie te wijzigen. Druk op Enter of Return om de waarde toe te passen.
De foto op geselecteerde foto roteert 12 graden tegen de klok in.



5 Selecteer frame 12 van de laag photo2. Klik vervolgens op photo2.jpg in het werkgebied.
6 Gebruik Eigenschapcontrole en het deelvenster Transformeren om de tweede foto op een

interessante manier te positioneren en roteren. Gebruik X = 80 en Y = 50 en de rotatiewaarde 6
om enig contrast te krijgen met de eerste foto.

7 Selecteer frame 24 in de laag photo3. Klik vervolgens op photo3.jpg in het werkgebied.
8 Gebruik Eigenschapcontrole en het deelvenster Transformeren om de derde foto op een aardige

manier te positioneren en roteren. Gebruik X = 120 en Y = 55 en de rotatiewaarde —2 om enig
contrast te krijgen met de andere foto’s.

Opmerking: als u afbeeldingen in Flash roteert kunnen ze er gekarteld uit komen te zien. U kunt
dit voorkomen door in het deelvenster Bibliotheek op het icoon voor de bitmap te dubbelklikken
waarna het venster Bitmapeigenschappen verschijnt. Hierin kunt u kiezen voor Effenen toestaan.





Zoom selecteert, verschijnen de opties Vergroten en Verkleinen.

Het deelvenster Gereedschappen bevat te veel gereedschappen om tegelijk weer te geven.
Sommige gereedschappen zijn ondergebracht in groepen in het deelvenster Gereedschappen;
alleen het gereedschap dat u als laatste hebt geselecteerd in een groep wordt weergegeven. Als er
zich een klein driehoekje in de rechterbenedenhoek van het pictogram bevindt, zijn er nog andere
gereedschappen beschikbaar in de groep. Klik op het driehoekje om de andere gereedschappen
zichtbaar te maken en selecteer een gereedschap in het menu.

U gaat nu het gereedschap Tekst gebruiken om een titel toe te voegen aan de animatie.

1 Selecteer de bovenste laag in de tijdlijn en klik op het pictogram Nieuwe laag.
2 Noem de nieuwe laag text.
3 Vergrendel de lagen eronder zodat u er niet per ongeluk iets naartoe verplaatst.
4 Beweeg de afspeelkop naar frame 36 en selecteer frame 36 in de laag text.
5 Kies Invoegen > Tijdlijn > Hoofdframe (F6) om een nieuw hoofdframe in te voegen bij frame 36.

6 Selecteer in het deelvenster Gereedschappen het gereedschap Tekst, aangeduid door
de grote hoofdletter T.

7 Kies in Eigenschapcontrole de optie Klassieke tekst in het menu. Kies Statische tekst
uit het menu dat eronder verschijnt.

Klassieke tekst is bedoeld voor het toevoegen van tekst zonder uitgebreide opties
zoals kolommen en tekst die om andere objecten heen loopt. Statische tekst is bedoeld
voor de weergave van tekst die niet verandert.
Dynamische tekst en Invoertekst zijn speciale
opties voor meer interactieve doeleinden en
kunnen worden beheerd met ActionScript.
Uitgebreide tekstopties worden in les 7
behandeld.

8 Selecteer in Eigenschapcontrole een lettertype en
tekengrootte. Uw computer beschikt mogelijk niet
over dezelfde lettertypen als in deze les worden
getoond, maar kies in dat geval een lettertype dat
er sterk op lijkt.

9 Klik in Eigenschapcontrole op het kleurvak om
een tekstkleur te kiezen. U kunt rechtsboven op
het kleurwiel klikken om de Adobe Kleurkiezer te
openen, of u kunt rechtsboven het percentage
wijzigen van de alfawaarde, waarmee de mate
van transparantie wordt bepaald.



10 Let erop dat het lege hoofdframe in frame 35 van de titellaag is geselecteerd. Klik vervolgens in
het werkgebied op de plek waar u tekst wilt gaan toevoegen.

11 Typ een titel die de in het werkgebied weergegeven foto’s beschrijft.
12 Verlaat het gereedschap Tekst door het gereedschap Selecteren (R ) te selecteren.

13 Gebruik Eigenschapcontrole of het deelvenster Transformeren om uw tekst in het werkgebied
desgewenst te verplaatsten of te roteren. Of kies het gereedschap Selecteren en sleep de tekst
simpelweg naar een nieuwe locatie op het werkgebied. De X- en Y-waarden in het deelvenster
Eigenschapcontrole worden aangepast terwijl u de tekst verspleept.

14 Uw animatie voor deze les is klaar! Vergelijk uw bestand met het voltooide projectbestand,
01End.fla.

Overzicht van het deelvenster Gereedschappen
Het deelvenster Gereedschappen bevat selectiegereedschappen, teken- en schildergereedschappen
en navigatiegereedschappen. In het optiegebied van het deelvenster kunt u het geselecteerde
gereedschap aanpassen. Het uitgevouwen menu rechts laat de verborgen gereedschappen zien. De



zwarte vierkantjes in het uitgevouwen menu rechts staan bij het standaardgereedschap dat in het
deelvenster Gereedschappen verschijnt. De hoofdletters tussen haakjes verwijzen naar de sneltoetsen
om deze gereedschappen te selecteren. Merk op dat de gereedschappen op basis van vergelijkbare
functies zijn gegroepeerd.



Stappen ongedaan maken in Flash
In een perfecte wereld gaat alles volgens plan. Maar soms moeten we een paar stappen achteruit
doen en opnieuw beginnen. In Flash kunt u stappen ongedaan maken met de opdracht Ongedaan
maken of met het deelvenster Historie.

Om een enkele stap ongedaan te maken kiest u Bewerken > Ongedaan maken, of gebruikt
u de toetsencombinatie Ctrl/Command+Z. Om een ongedaan gemaakte stap opnieuw uit te
voeren, kiest u Bewerken > Herhalen.

Als u meerdere stappen ongedaan wilt maken, kunt u beter het deelvenster Historie gebruiken, dat
een lijst laat zien van de laatste 100 stappen die u hebt uitgevoerd. Als u een document sluit, wist u
de geschiedenis ervan.

Kies Venster > Andere deelvensters > Historie om het deelvenster Geschiedenis te openen.

Als u bijvoorbeeld niet tevreden bent over de toegevoegde tekst, kunt u uw werk ongedaan
maken en terugkeren naar een eerdere staat van uw Flash-document.

1 Kies Bewerken > Ongedaan maken om uw laatste handeling ongedaan te maken. U kunt de
opdracht net zo vaak uitvoeren als het aantal stappen dat in het deelvenster Historie staat. U
kunt dit maximale aantal stappen wijzigen met Bewerken > Voorkeuren.

2 Kies Venster > Andere deelvensters > Historie om het deelvenster Historie te openen.
3 Sleep de schuifbalk van het deelvenster Historie naar de stap direct vóór de gemaakte fout. De

daaronder gelegen stappen worden grijs in het deelvenster en uit het project verwijderd. Om een
stap weer toe te voegen, sleept u de schuifbalk naar de betreffende stap.

Opmerking: als u stappen in het deelvenster Historie verwijdert en vervolgens nieuwe stappen uit-
voert, zijn de verwijderde stappen niet langer beschikbaar.

Een voorbeeld van de film bekijken
Tijdens het werken aan een project is het verstandig om met enige regelmaat het voorlopige
resultaat te bekijken om er zeker van te zijn dat u op de goede weg zit. Als u snel wilt zien hoe een
animatie of film eruit zal zien voor de toeschouwer, kiest u Besturing > Film testen > in Flash
Professional. U kunt ook de toetsencombinatie Ctrl+Enter of Command+Return gebruiken.



1 Kies Besturing > Film testen > in Flash Professional.
Flash speelt de film af in een apart venster.

Flash maakt een SWF-bestand op dezelfde plaats als
het FLA-bestand en opent het bestand in een eigen
scherm. Een SWF-bestand is het gecomprimeerde
bestand dat u naar het web kunt uploaden.

Flash herhaalt de film automatisch in deze voor-
beeldmodus. Als u niet wilt dat de film steeds herhaald
wordt, kiest u Besturing > In lus afspelen om deze optie
uit te schakelen.

2 Sluit het voorbeeldvenster.
3 Klik op met het gereedschap Selecteren op het werkgebied. Aan

de onderzijde van het deelvenster Eigenschapcontrole ziet u de
bestandsgrootte en de datum en de tijd van het meest recente
SWFbestand. Ook wordt er een logboek bijgehouden. Met behulp
hiervan kunt u uw voortgang bijhouden.

De film publiceren
Als u zover bent dat u het resultaat wilt delen met anderen, kunt u de
film vanuit Flash publiceren. Flash creëert voor de meeste projecten
een HTML-bestand en een SWF-bestand. Het SWF-bestand is uw
voltooide film, het HTML-bestand vertelt uw webbrowser hoe het
SWFbestand moet worden weergegeven. U dient beide bestanden te
uploaden naar dezelfde map op uw webserver. Test de film altijd na
het uploaden om er zeker van te zijn dat hij correct wordt
weergegeven.

Opmerking: publicatieopties komen uitgebreid aan bod in les 10.

1 Kies Bestand > Publicatie-instellingen.



2 Klik op de tab Indelingen.
3 Selecteer Flash (.swf) en HTML (.html).

4 Klik op de tab HTML.
5 Schakel de Lus-optie uit.
6 Klik op Publiceren onderin het scherm Publicatie-instellingen.
7 Klik op OK om het dialoogvenster te sluiten.
8 Navigeer naar de map Lesson01\01Start om de bestanden te zien die Flash heeft aangemaakt.

De film opslaan
U hebt uw film al opgeslagen als FLA-bestand, maar u kunt de film ook opslaan in een onge-
comprimeerd bestandsformaat, het zogenoemde XFL-formaat. Dit formaat is in feite een map met
bestanden in plaats van een enkel document. Het XFL-formaat stelt de inhoud van uw Flash-film
beschikbaar aan andere ontwikkelaars en ontwerpers zodat zij de inhoud van uw bestand
eenvoudig kunnen bewerken of beheren zonder de film in Flash te hoeven openen.

Alle geïmporteerde foto’s in het deelvenster Bibliotheek staan bijvoorbeeld bij elkaar in een map in
het XFL-formaat. U kunt de foto’s bewerken of vervangen door andere foto’s. Flash zal de
veranderingen automatisch overnemen in de film.

1 Kies Bestand > Opslaan als.
2 Noem het bestand 01_workingcopy.xfl en kies Niet-gecomprimeerd Flash CS5-document (*.xfl).

Klik Opslaan.
Flash maakt een map aan met de naam Ol_workingcopy met daarin alle informatie over uw
Flash-film.

3 Sluit het Flash-document met Bestand > Sluiten.

Een XFL-document wijzigen
In deze stap zult u de Biobliotheekmap van het XFL-document wijzigen en daarmee een ver-
andering in uw Flash-film aanbrengen.

1 Open de map LIBRARY in de map O1_workingcopy.
Deze map bevat alle foto’s die u in uw Flash-film geïmporteerd hebt.

2 Verwijder het bestand photo3.jpg.



3 Sleep het bestand photo4.jpg uit de map 01Start en verplaats het naar de map LIBRARY binnen
de map O1_workingcopy. Wijzig de naam van photo4.jpg naar photo3.jpg.

De vervanging van photo3.jpg met een andere afbeelding wordt automatisch in Flash
doorgevoerd.

4 Om een XFL-document te openen dubbelklikt u op het .xfl-bestand.
De laatste afbeelding in hoofdframe 24 van de tijdlijn is verwisseld met de afbeelding van photo4.jpg.

Hulpmiddelen voor het gebruik van Flash
Bezoek de website van Adobe voor volledige en actuele informatie
over het gebruik van de deelvensters van Flash, gereedschappen en
andere voorzieningen. Kies Help > Flash Help. U wordt dan
verbonden met help.adobe.com/nl_NL, waar u Flash-hulpbestanden
en andere relevante websites kunt doorzoeken. U kunt uw
zoekopdracht ook inperken tot enkel Help-bestanden van Adobe zelf.

Als u van plan bent met Flash te werken zonder internetverbinding,
download dan de meest actuele pdf-versie van Flash Help van
www.adobe.com/support/documentation/nl.

Ga voor extra hulpmiddelen, zoals tips en trucs en de laatste product-



informatie, naar de Help-pagina van de Adobe-gebruikersgroepen op community.adobe.com/help/main
of ga naar www.adobe.com/nl/.

Opmerking: als Flash vaststelt dat u niet verbonden bent met internet bij het starten van de toepassing,
kunt u met Flash > Flash Help de interne HTML-hulppagina’s van Flash openen. Raadpleeg voor
actuelere informatie de online Help-bestanden of download het nieuwste pdfbestand.

Controleren op updates
Adobe voorziet periodiek in updates voor software. Als u
beschikt over een actieve internet-verbinding, hebt u
gemakkelijk toegang tot deze updates via de Adobe
Application Manager.

1 Kies in Flash de menuoptie Help > Updates. De Adobe
Application Manager gaat automa-tisch controleren op
beschikbare updates voor uw Adobe-software.

2 Selecteer in het dialoogvenster Adobe Application
Manager de updates die u wilt installeren en klik
vervolgens op Updates downloaden en installeren.

Opmerking: kies Help > Updates en vervolgens Voorkeuren
in de Adobe Application Manager om uw voorkeuren voor
toekomstige updates in te stellen. Geef op hoe vaak u Adobe Application Manager op beschikbare
updates wilt laten controleren, voor welke toepassingen, en of ze automatisch moeten worden
gedownload. Klik op OK om de nieuwe instellingen te bevestigen.

Oefenvragen
1 Wat is het werkgebied?
2 Wat is het verschil tussen een frame en een hoofdframe?
3 Wat is een verborgen gereedschap en hoe krijgt u er toegang toe?
4 Noem twee manieren om in Flash stappen ongedaan te maken en beschrijf die technieken.
5 Hoe kunt u antwoorden vinden op vragen die u hebt over Flash?

Antwoorden
1 Het werkgebied is het gebied dat de kijker te zien krijgt wanneer een film wordt afgespeeld in de

Flash Player of een webbrowser. Het bevat de tekst, afbeeldingen en video die op het scherm
verschijnen. Objecten die u op het Plakbord buiten het werkgebied hebt geplaatst, verschijnen
niet in de film.

2 Een frame vertegenwoordigt een tijdeenheid in de tijdlijn. Een hoofdframe wordt in de tijdlijn
weergegeven met een cirkel en geeft aan dat er iets verandert aan de inhoud van het
werkgebied.

3 Omdat er te veel gereedschappen zijn om ineens te laten zien in het deelvenster Gereed-
schappen, zijn sommige gereedschappen ondergebracht in een groep waarvan steeds één
gereedschap wordt weergegeven (namelijk het gereedschap dat u het laatst hebt gebruikt). Er
verschijnen kleine driehoekjes onder aan gereedschapspictogrammen om aan te geven dat er
verborgen gereedschappen aanwezig zijn. U selecteert een verborgen gereedschap door de
muisknop ingedrukt te houden op het pictogram en vervolgens een gereedschap te kiezen in het
menu.



4 U kunt in Flash stappen ongedaan maken met de opdracht Ongedaan maken of het deelvenster
Historie. Om steeds één stap per keer ongedaan te maken kiest u Bewerken > Ongedaan
maken. Sleep de schuifbalk omhoog in het deelvenster Historie als u meerdere stappen ineens
ongedaan wilt maken.

5 Kies Help > Flash Help om de Help-bestanden te raadplegen over Flash CS5 en ActionScript
3.0. Kies Help > Hulpmiddelen online of bezoek www.adobe.com/nl/ voor tutorials, tips en
andere hulpmiddelen voor Flash-gebruikers.







Het gereedschap Ovaal gebruiken
Nu gaan we de opening bovenin en de afgronde bodem maken.

1 Klik op het gereedschap Rechthoek en houd de muis-knop ingedrukt
zodat de verborgen gereedschappen zichtbaar worden. Kies het
gereedschap Ovaal.

2 Zorg dat de optie Objecten magnetisch aan staat.
Door deze aan te zetten sluiten de hoeken en lijnen van de vormen netjes op elkaar aan.

3 Klik binnen het rechthoek en sleep eroverheen om een ovaal binnen het rechthoek te maken.
Door de optie Objecten magnetisch sluit het ovaal netjes aan op de randen van het rechthoek.

4 Teken nog een ovaal bij de onderkant van het rechthoek.

Opmerking: Flash past de laatst gebruikte kleur voor streek en vulling toe.

Selecteren
Om iets aan een oject te kunnen wijzigen moet u eerst in staat zijn verschillende onderdelen ervan
te selecteren. In Flash kunt hiervoor gebruikmaken van het gereedschap Selecteren, Subselectie
of Lasso. Normaal gesproken gebruikt u het gereedschap Selecteren om een object in z’n geheel
of een gedeelte ervan te selecteren. Met het gereedschap Subselectie kunt u een specifiek punt of
een specifieke lijn van een object selecteren. Met de Lasso maakt u een selectie vanuit de vrije
hand.

Streken en vullingen selecteren
We gaan de rechthoek en de ovalen nu meer op een koffiekopje laten lijken. Gebruik het
gereedschap Selecteren om ongewenste streken en vullingen te verwijderen.

1 Selecteer het gereedschap Selecteren in het deelvenster Gereedschappen.
2 Door erop te klikken kun u de vulling boven het bovenste ovaal selecteren. De vorm boven het

bovenste lokaal wordt nu uitgelicht.
3 Druk op de toets Delete. De vorm is nu verwijderd.
4 Selecteer elk van de drie lijnsegmenten boven het bovenste ovaal en druk op de toets Delete.

De afzonderlijke streken zijn nu verwijderd zodat het bovenste ovaal nu verbonden is met de
rechthoek.

5 Selecteer nu de vulling en de streken onder het onderste ovaal en ook de binnenste curve bij de
onderkant van het kopje en druk op de toets Delete.
Er blijft nu een cylindervormig object over.

Opmerking: Houd Shift ingedrukt bij het maken van selecties om meerdere vullingen of streken
tegelijk te selecteren.



Vormen bewerken
Bij het tekenen in Flash zult u vaak het gereedschap Rechthoek en Ovaal gebruiken. Maar om
meer complexe vormen te maken gebruikt u andere gereedschapschappen om de basisvormen te
aan te passen. Met behulp van het gereedschap Vrije Transformatie, met kopiëren en plakken en
met het gereedschap Selecteren kunt u de eenvoudige cilinder omtoveren in een koffiekopje.

Het gereedschap Vrije Transformatie gebruiken
Het koffiekopje ziet er realistischer uit als het aan de onderkant een beetje taps toeloopt. U gebruikt
het gereedschap Vrije Transformatie om de vorm in grote lijnen te bewerken. Met het gereedschap
Vrije Transformatie kunt u de controlepunten van een object verslepen en het zo schalen, roteren,
afschuinen en vervormen.

1 Selecteer het gereedschap Vrije Transformatie.
2 Sleep het gereedschap Vrije Transformatie rond de cilinder in het werkgebied

om deze te selecteren. Op de cilinder verschijnen nu transformatiegrepen.
3 Gebruik de toetsencombinatie Ctrl/Command+Shift terwijl u een van de binnenste

hoeken naar binnen sleept. Door deze toetsen tijdens het slepen ingedrukt te houden,
kunt u beide hoeken gelijktijdig even ver naar binnen verplaatsen.

4 Klik buiten de vorm om de selectie op te heffen.
De onderkant van de cilinder is nu smal en de bovenkant breed. Het begint al op een koffiekopje
te lijken.

Opmerking: Als u op Alt of Optie drukt terwijl u een van de controlepunten verplaatst wordt het
geselecteerde object geschaald ten opzichte van het transformatiepunt, dat wordt afgebeeld als
een cirkeltje. U kunt het transformatiepunt overal naartoe verplaatsen, zelfs buiten het object. Druk
op Shift om de verhoudingen van het object te behouden. Druk op Ctrl/Command om het object
vanuit een enkel controlepunt te vervormen.

Kopiëren en plakken gebruiken
Met behulp van kopiëren en plakken is het eenvoudig om vormen in het werkgebied te dupliceren. U
gaat het koffieoppervlak maken door de bovenste rand van het koffiekopje te kopiëren en te plakken.

1 Houd Shift ingedrukt en selecteer het bovenste en onderste gebogen lijntje van de
opening van het koffiekopje.

2 Kies Bewerken > Kopiëren (Ctrl/Command+C). De bovenste streken van het ovaal zijn
gekopieerd.

3 Kies Bewerken > In midden plakken. (Ctrl/Command+V)
Flash plaast een kopie in het midden van het werkgebied.

4 Selecteer het gereedschap Vrije Transformatie.
Op het ovaal verschijnen handgrepen.

5 Houd Shift en Alt/Option ingedrukt terwijl u de hoeken naarbinnen sleept. Maak het
ovaal ongeveer tien procent kleiner. Door Shift in te drukken verandert de vorm van het



ovaal op uniforme wijze zodat de verhoudingen hetzelfde blijven. Door Alt/Option in te drukken
verandert het ovaal van vorm ten opzichte van het transformatiepunt.

6 Selecteer het gereedschap Selecteren.
7 Sleep het ovaal over de rand van het koffiekopje, zodanig dat het voorste randje

overlapt wordt.
8 Klik naast het ovaal zodat het niet meer geselecteerd is.
9 Selecteer het onderste gedeelte van het kleine ovaal en verwijder het. Uw koffiekop is

nu gevuld met koffie!

De contouren van een vorm veranderen
Met het gereedschap Selecteren kunt u lijnen en hoeken ombuigen om zo het algehele contour
van een vorm te veranderen. Het is een snelle en intuïtieve manier om met vormen om te gaan.

1 Kies het gereedschap Selecteren.
2 Verplaats de muiscursor dicht naar een van de randen van het koffiekopje.

Er verschijnt nu een gebogen lijn bij de cursor die aangeeft dat u de
kromming van de streek kunt veranderen.

3 Klik en sleep de streek naar buiten.
De zijkant van de koffiekop buigt waardoor het kopje een beetje bol komt te
staan.

4 Klik en sleep de de andere kant van het kopje ook iets naar buiten.
Het koffiekopje heeft nu een iets rondere vorm.

Opmerking: houd bij het verslepen van een streek Alt/Option ingedrukt om een nieuwe hoek toe
te voegen.

Streken en vullingen wijzigen
Wilt u de eigenschappen van een streek of vulling wijzigen dan kunt u het gereedschap Inkt-
fles of het gereedschap Emmertje gebruiken.

1 Kies het gereedschap Emmertje
2 Kies een donkerbruine kleur (#663333) in Eigenschapcontrole.

3 Klik op het bovenoppervlak van de koffie in het koffiekopje.
De vulling van het bovenste ovaal wordt nu donkerbruin.

Opmerking: Als het gereedschap Emmertje de vulling in omliggende gebieden verandert kan het
zijn dat er een klein gat is dat ervoor zorgt dat de vulling overloopt. Sluit het gat, of kies een andere
tussenruimtegrootte aan de onderzijde van het deelvenster Gereedschappen.



4 Kies het gereedschap Inktfles. Dit gereedschap zit verborgen onder de Emmertje.
5 Kies een nog donkerder kleur (#330000) in Eigenschapcontrole.
6 Klik op de bovenste streek van het oppervlak van de koffie in het kopje. De streek rond het

oppervlak van de koffie wordt nu donkerder van kleur.

Opmerking: u kunt de streek of de vulling ook selecteren en de kleur vervolgens in Eigenschapcontrole
wijzigen zonder van het gereedschap Emmertje of Inktfles gebruik te maken.

Tekenmodi in Flash
Flash bevat drie tekenmodi, die bepalen hoe objecten op elkaar reageren in het werkgebied en hoe u
ze kunt bewerken. Standaard maakt Flash gebruik van de gemengde tekenmodus, maar u kunt ook de
objecttekenmodus activeren of de primitieve tekenmodus gebruiken (met de gereedschappen
Rechthoek Primitief of Ovaal Primitief).

Gemengde tekenmodus
In deze modus mengt Flash getekende vormen, zoals rechthoeken en ovalen, daar waar ze elkaar
overlappen, zodat meerdere vormen één vorm opleveren. Als u een vorm die met een andere vorm
is gemengd verplaatst of wist, wordt het overlappende gedeelte permanent verwijderd.

De objecttekenmodus
In deze modus mengt Flash getekende objecten niet; het blijven afzonderlijke objecten, ook als ze
elkaar overlappen. U activeert deze modus door het gewenste gereedschap te selecteren en
vervolgens op het pictogram Objecttekenmodus te klikken in het optiegedeelte van het deelvenster
Gereedschappen.

Om een object om te zetten in vormen (gemengde tekenmodus), selecteert u het object en gebruikt
u de toetsencombinatie Ctrl/Command+B. Om een vorm om te zetten in een object (objectteken-
modus), selecteert u de vorm en kiest u Wijzigen > Objecten combineren > Vereniging.

Primitieve tekenmodus
Wanneer u de gereedschappen Rechthoek Primitief of Ovaal Primitief gebruikt, tekent Flash de
vormen als afzonderlijke objecten. Maar anders dan bij reguliere objecten, kunt u in Eigen-
schapcontrole de afronding van de hoeken van rechthoekprimitieven wijzigen, evenals de
begin- en eindhoek en de binnenradius van ovaalprimitieven.



Een kleurverloop en een bitmapvulling gebruiken
De vulling is het binnenste van een getekend object. Op dit moment heeft u een enkele kleur, maar
u kunt ook een kleurverloop of een bitmap-afbeelding (zoals een JPEG-bestand) als vulling
gebruiken, of u kunt aangeven dat het object helemaal geen vulling moet hebben.
Bij een kleurverloop gaat de ene kleur geleidelijk over in een andere. Flash kan lineaire kleur-
verlopen creëren, waarbij de kleur horizontaal, verticaal of diagonaal verandert, of radiale
kleurverlopen, waarbij de kleur naar buiten toe verloopt vanuit een centraal beginpunt. In deze les
gaat u een lineair kleurverloop toepassen om een driedimensionaal effect aan het koffiekopje toe
te voegen. Voor het maken van een schuimkraag importeert u een bitmap-afbeelding om als vulling
te gebruiken. U kunt een bitmap-bestand importeren in het deelvenster Kleur.

Kleurverlopen maken
U definieert de kleuren die u in een kleurverloop wilt gebruiken in het deelvenster Kleur. Standaard
loopt een lineair verloop van de ene kleur over in de andere, maar u kunt in Flash tot maximaal
vijftien kleurovergangen gebruiken in een kleurverloop. Een kleuraanwijzer bepaalt waar het
verloop van de ene kleur overgaat in de andere. Plaats kleuraanwijzers onder de verloopbalk om
kleurovergangen toe te voegen.

We gaan nu een verloop maken waarbij de kleur van bruingeel via wit naar donkerder bruin loopt
zodat het koffiekopje een rond uiterlijk krijgt.

1 Kies het gereedschap Selecteren. Selecteer de vulling die het voorste oppervlak van het
koffiekopje vertegenwoordigt.

2 Open het deelvenster Kleur (Venster > Kleur), klik op het pictogram Vulkleur en selecteer Lineair
in de vervolgkeuzelijst Type. De voorkant van het koffiekopje wordt van links naar rechts gevuld
met een kleurverloop.



3 Selecteer de kleuraanwijzer links van het kleurverloop in het deelvenster
Kleur (het driehoekje erboven wordt zwart als het geselecteerd is) en typ
FFCCCC in het vak voor de hexadecimale waarde om de aanwijzer een
lichte bruingele kleur mee te geven. Druk op Enter of Return om de kleur
toe te passen. U kunt ook een kleur uit de kleurenkiezer nemen of
dubbelklikken op de aanwijzer om een kleur uit de kleurstalen te kiezen.

4 Selecteer de meest rechter kleuraanwijzer en geef de waarde B86241 op
voor een donkere bruingele kleur. Druk op Enter of Return om de kleur toe
te passen.
Het kleurverloop voor de koffiekop loopt nu geleidelijk van lichtbruin naar
donkerbruin.

5 Klik onder de verloopbalk om een nieuwe aanwijzer toe te voegen.
6 Sleep de nieuwe kleuraanwijzer naar het midden van het kleurverloop.

Opmerking: om een kleuraanwijzer te verwijderen sleept u hem eenvoudig van de balk.

7 Selecteer de nieuwe kleuraanwijzer en typ #FFFFFF in het vak voor de hexadecimale waarde
om de aanwijzer de kleur wit mee te geven. Druk op Enter of Return om de kleur toe te passen.
Het kleurverloop voor de koffiekop loopt nu geleidelijk van lichtbruin via wit naar donkerbruin.

8 Deselecteer de vulling door elders in het werkgebied te klikken. Kies het gereedschap Emmertje
en zorg dat de optie Vulling vergrendelen aan de onderkant van het deelvenster
Gereedschap uit staat.
De optie Vulling vergrendelen zet het huidige kleurverloop vast aan de eerste vorm
waarop het toegepast is zodat het verloop doorgetrokken wordt naar volgende
vormen. We willen een nieuw verloop voor de achterkant van de koffiekop dus de
optie Vulling vergrendelen moet uit staan.

9 Selecteer de achterkant van het koffiekopje met het gereedschap Emmertje. Het
verloop wordt nu toegepast op de achterkant.

Het gereedschap Verlooptransformatie gebruiken
Naast ket kiezen van kleuren en de positionering van de kleuraanwijzers kunt u ook de grootte,
richting en het middelpunt van een verloopvulling aanpassen. Om het kleurverloop binnen de
voorkant van het kopje te duwen en het om te draaien voor de achterkant gebruiken we het
gereedschap Verlooptransformatie.

1 Selecteer het gereedschap Verlooptransformatie. (Het gereedschap
Verlooptransformatie vormt een groep met het gereedschap Vrije
transformatie).

2 Klik op de voorkant van het koffiekopje. Er verschijnen transformatie-
grepen.

3 Sleep de verticale greep aan de zijkant van het glas naar binnen om
het kleurverloop dichter te duwen. Sleep de cirkel om het verloop naar
links te verplaatsen zodat de witte glans iets links van het midden komt.

4 Klik nu op de achterkant van het koffiekopje. Er verschijnen weer transformatiehandgrepen.



5 Sleep de ronde greep in de hoek om het verloop 180 graden te draaien zodat het verloop van
donker links naar wit en licht rechts gaat.

Opmerking: verplaats de cirkel om het middelpunt van het kleurverloop te wijzigen; sleep de pijl-
cirkel om het verloop te roteren; of sleep de pijl in het vierkant om het verloop uit te rekken.

Het koffiekopje ziet er nu realistischer uit omdat schaduw en glans ervoor zorgen dat de voorkant
bol lijkt en de achterkant hol.

Een bitmapvulling toevoegen
We maken het koffiekopje nog iets echter door een schuimkraagje toe te
voegen. We gebruiken een JPEG-afbeelding van schuim als
bitmapvulling.

1 Selecteer het bovenoppervlak van de koffie met het gereedschap
Selecteren.

2 Open het deelvenster Kleur (Venster > Kleur).
3 Selecteer Bitmapvulling.
4 In het dialoogvenster Importeren in bibliotheek kiest u voor

coffeecream.jpg in de map Lesson02/02Start.
5 Selecteer coffeecream.jpg en klik op Openen.

Opmerking: met het gereedschap Verlooptransformatie kunt u de manier waarop een bitmapvul-
ling toegepast wordt ook veranderen.

Het oppervlak van de koffie vult zich met de afbeelding van de schuimkraag. Het
koffiekopje is af! Wijzig de naam van de laag met het koffiekopje in coffee. Nu hoeven
we alleen nog maar wat bubbels en hete stoom toe te voegen.

Objecten groeperen
Nu u klaar bent met het maken van het koffiekopje kunt u er een afzonderlijke groep van maken.
Een groep houdt een verzameling vormen en andere afbeeldingen bij elkaar om de integriteit ervan
te waarborgen. Als het koffiekopje gegroepeerd is kunt u het als eenheid verplaatsen zonder dat u
bang hoeft te zijn dat het samengevoegd wordt met onderliggende vormen. Gebruik groepen om
uw tekening te organiseren.

1 Kies het gereedschap Selecteren.
2 Selecteer alle vormen waaruit het koffiekopje is opgebouwd.
3 Kies Wijzigen > Groeperen.

Het koffiekopje is nu een enkele groep. Wanneer u het selecteert wordt het omgeven
door een blauwe omkadering.

4 Dubbelklik op de groep indien u een gedeelte van de koffiekop wilt bewerken.



Merk op dat alle andere elementen in het werkgebied grijs worden
gemaakt en dat in de horizontale balk boven het werkgebied Scène 1
Groep staat vermeld. Daarmee wordt aangegeven dat u zich nu in een specifieke groep bevindt
en de inhoud ervan kunt bewerken.

5 Klik in de balk boven aan het werkgebied op het pictogram Scène 1 of dubbelklik op een leeg
gedeelte van het werkgebied om terug te keren naar de hoofdscène.

Opmerking: om een groep terug te veranderen in de afzonderlijke vormen kiest u voor Wijzigen >
Groep opheffen (Shift+Ctrl+G in Windows of Shift+Command+G op de Mac).

Patronen en decoraties maken
U kunt ingewikkelde patronen maken met het gereedschap Deco ((y), dat in Flash CS5
Professional veel nieuwe penselen heeft. Aan de hand van vele opties kunt u snel en gemakkelijk
symmetrische ontwerpen, rasters of zich vertakkende sierkrullen maken. In deze les gaat u het
gereedschap Deco gebruiken voor het maken van bruisende symmetrische vormen en gestreepte
lijnen te maken om de banner meer slagkracht te geven en voor het maken van bloemvormige
decoraties om de randen te versieren.

Een symbool creëren voor een patroon
Voordat u de symmetriepenseel van het gereedschap Deco kunt gebruiken, moet u eerst een
symbool maken dat als basisvorm wordt gebruikt voor de herhaling van de vorm. U leert meer over
symbolen in de volgende les.

1 Kies Invoegen > Nieuw Symbool.
2 Geef in het dialoogvenster Nieuw symbool maken line op als naam en kies Afbeelding als type.

Klik op OK.

3 Flash schakelt onmiddellijk over op de symboolbewerkingsmodus. In de
horizontale balk boven het werkgebied ziet u staan dat u momenteel het
symbool line aan het bewerken bent.

4 Selecteer het gereedschap Lijn
5 Selecteer een bruine kleur voor de omtrek en Haarlijn voor de streekstijl. Een streek met de stijl

Haarlijn behoudt een uniforme dikte, hoe groot of klein u het object ook schaalt.



6 Houd de Shift-toets ingedrukt en teken een lijn in het midden van het werkgebied, waar een
dradenkruis het centrale punt van het symbool aanduidt. Maak de lijn ongeveer 25 pixels hoog.

7 Klik in de horizontale balk boven het werkgebied op Scène 1 om terug te keren naar de
hoofdtijdlijn. Het nieuwe symbool line is gemaakt en opgeslagen in het deelvenster Bibliotheek
voor later gebruik.

De symmetriepenseel van het gereedschap Deco gebruiken
U gaat met het gereedschap Deco een stervorm maken.

1 Voeg in de tijdlijn een nieuwe laag in en noem die coffee aroma. U gaat de symmetrische
vormen in deze laag maken.

2 Selecteer het gereedschap Deco in de gereedschapsbalk.
3 Kies in Eigenschapcontrole de optie Symmetriepenseel.

4 Klik op de knop Bewerken naast Module om de basisvorm te wijzigen.
5 Kies in het dialoogvenster Symbool selecteren het symbool line. Klik op OK.

6 Kies onder Geavanceerde opties de optie Roteren rond.
Met deze opties van het gereedschap Deco kunt u een herhalend
patroon maken van het line-symbool dat symmetrisch is rond een vast
punt. In het werkgebied verschijnt een groene hulplijn ter aanduiding van
het centrale punt, de hoofdas en een secundaire as die bepaalt hoe vaak
het symbool wordt herhaald.



7 Klik in het werkgebied om uw symbool te plaatsen en sleep het met de muisknop ingedrukt
langs de groene hulplijnen totdat het gewenste stralenpatroon is bereikt. De oorspronkelijke lijn
hoort verticaal te zijn.

8 Sleep de secundaire groene as dichter naar de hoofdas om meer herhalingen te genereren.

9 Als u klaar bent, kiest u het gereedschap Selecteren om het gereedschap Deco te verlaten. Het
resultaat is een groep die bestaat uit een aantal line-symbolen.

Objecten uitlijnen
U gaat nu een belletje maken dat in het midden van de stralenkrans moet komen te staan. Omdat
het belletje precies in het midden moet komen, wenden we ons tot het deelvenster Uitlijnen. Met
het deelvenster Uitlijnen kunt u elk aantal geselecteerde objecten horizontaal of verticaal uitlijnen.
Ook kan het objecten gelijkmatig verdelen.

1 Selecteer het gereedschap Ovaal.
2 Selecteer een bruine kleur voor de streek en geen vulling. Om

geen vulling te selecteren kiest u het vakje met een diagonale
rode lijn erdoorheen. Kies Haarlijn als streekstijl.

3 Selecteer de laag coffee aroma. Houd de Shift-toets ingedrukt
terwijl u een kleine cirkel tekent in het werkgebied.

4 Kies nu het gereedschap Selecteren.
5 Sleep het gereedschap Selecteren over zowel de stervormige groep als

het zojuist getekende ovaal. Wellicht moet u de onderliggende laag
vergrendelen zodat u niet per ongeluk vormen in de lagere lagen
selecteert.

6 Open het deelvenster Uitlijnen (Venster > Uitlijnen).
7 Klik op de knop Horizontaal midden uitlijnen. De stervormige groep and

het ovaal worden horizontaal uitgelijnd.



8 Klik op de knop Verticaal midden uitlijnen. De stervormige groep en het ovaal worden verticaal
uitgelijnd.

Objecten splitsen en groeperen
U hebt het gereedschap Deco gebruikt om de stervormige groep met lijnen te maken en het
deelvenster Uitlijnen om het belletje daarbinnen te centreren. U maakt nu van de bruisvorm een
afzonderlijke eenheid. Daarvoor gaat u de groep met lijnen splitsen en deze weer hergroeperen
met de cirkel erbij.

1 Sleep met het gereedschap Selecteren rond de hele ster, zodat alle lijnen en de cirkel zijn
geselecteerd.

2 Kies Wijzigen > Splitsen. De groep lijnen valt uiteen in de samenstellende delen en wordt een
verzameling van fizzy line-symbolen.

3 Kies nogmaals Wijzigen > Splitsen. De verzameling van line-symbolen valt uiteen in
de samenstellende delen en wordt een verzameling streken.

4 Kies Wijzigen > Groeperen. De lijnen en de middencirkel worden een enkele
groep.

5 Kopieer en plak de groep om meerdere bubbels vlak boven het koffiekopje te
maken. Gebruik het gereedschap Vrije transformatie om bubbels van
verschillende grootte te maken.

Het decoratief penseel van het gereedschap Deco gebruiken
Nu gaat u het decoratief penseel gereedschap Deco gebruiken, waarmee u decoratieve randen
en complexe lijnpatronen kunt maken.

1 Kies in het deelvenster Gereedschappen het gereedschap Deco.
2 Kies de optie Decoratief penseel in het deelvenster Eigenschapcontrole.
3 Selecteer Stippellijn bij de Geavanceerde opties. Kies een donkerbruine kleur voor

Patroonkleur en laat Patroongrootte en Patroonbreedte op hun standaardwaarden.
4 Teken een paar gebogen lijnen op het werkgebied, boven de koffiekop.



Met het decoratief penseel maakt u gestreepte lijntjes waardoor uw koffiekopje een beetje
levendiger wordt!

Opmerking: met de gereedschappen Lijn en Potlood kunt u ook gestreepte lijnen en verschillende
lijnpatronen maken, maar u kunt er geen herhaalde complexe patronen mee maken zoals u met
het gereedschap Deco kunt. In Eigenschapcontole kunt u op de knop Streekstijl bewerken klikken
om de streken van de gestreepte lijnen naar uw hand te zetten.

Het bloempenseel van het gereedschap Deco gebruiken
U gaat nu bloempatronen maken om de randen van de banner te decoreren.

1 Kies in het deelvenster Gereedschappen het gereedschap Deco.
2 Kies bij Eigenschapcontrole de optie Bloempenseel.
3 Selecteer Tuinbloem bij Geavanceere opties. Kies de optie Takken en laat de kleuren en

groottes op hun standaardwaarden.
4 Teken met een vegende beweging een tak langs de onderkant van het werkgebied.



De bloemen, bladeren, vruchten en zijtakken worden herhaaldelijk gegenereerd terwijl u met het
penseel over het werkgebied gaat.

5 Selecteer alle bloemen, bladeren, vruchten en zijtakken. Kies Wijzigen > Groeperen. De
bloemdecoratie wordt nu tot een enkele groep gecombineerd die u als eenheid kunt verplaatsen
of wijzigen.

Curven maken
U heeft gereedschap Selecteren gebruikt om vormranden in te drukken of uit te rekken om zo
intuïtief curven te maken. U kunt het gereedschap Pen , gebruiken voor meer controle.

Het gereedschap Pen gebruiken
U gaat een rustgevend, golvend achtergrondplaatje maken.

1 Kies Invoegen > Tijdlijn > Laag en noem de nieuwe laag dark
brown wave.

2 Sleep de laag naar de bodem van de laagstapel.
3 Vergrendel alle andere lagen.
4 Selecteer in het deelvenster Gereedschappen het gereedschap

Pen
5 Stel de streekkleur in op donkerbruin.
6 Begin de vorm door in het werkgebied te klikken om zo het eerste ankerpunt te bepalen.
7 Klik op een ander deel van het werkgebied om het volgende ankerpunt in

de vorm vast te leggen. Als u een vloeiende curve wilt maken, klik en
sleep dan met het gereedschap Pen.
Aan het ankerpunt verschijnen grepen die de kromming van de curve aanduiden.

8 Ga door met klikken en slepen om de golf vorm te geven. Maak de breedte van de golf groter
dan het werkgebied.



9 Sluit de vorm af door op het eerste ankerpunt te klikken. De curven hoeven niet allemaal perfect
te zijn, het vereist de nodige oefening om gewend te raken aan het gereedschap Pen. In het
volgende deel van de les krijgt u nog de kans de curven bij te werken.

10 Selecteer het gereedschap Emmertje.
11 Stel de vulkleur in op donkerblauw.
12 Klik binnen de zojuist gemaakte omtrek om deze in te kleuren en verwijder de streek.

Curven bewerken met de gereedschappen Selecteren en Subselectie
Uw eerste poging om vloeiende curven te maken is vermoedelijk geen doorslaand succes
geworden. Gebruik de gereedschappen Selecteren of Subselectie om correcties aan te brengen.

1 Kies het gereedschap Selecteren.
2 Beweeg de muisaanwijzer over een lijnsegment en kijk naar de kleine curve die ernaast

verschijnt. Dit geeft aan dat u de curve kunt bewerken. Als bij de muisaanwijzer een hoekje
verschijnt, is dat een teken dat u het knooppunt kunt bewerken.

3 Sleep de curve om de vorm ervan aan te passen.
4 Selecteer in het deelvenster Gereedschappen het

gereedschap Subselectie.
5 Klik op de omtrek van de vorm.
6 Sleep de ankerpunten naar een nieuwe positie of

verplaats de grepen om de golfvorm te verfijnen.



Ankerpunten verwijderen of toevoegen
Gebruik de verborgen gereedschappen onder het gereedschap Pen om desgewenst ankerpunten
te verwijderen of toe te voegen.

1 Klik op het gereedschap Pen en houd de muisknop ingedrukt om
toegang te krijgen tot de bijbehorende verborgen gereedschappen.

2 Selecteer het gereedschap Ankerpunt verwijderen
3 Klik op een ankerpunt op de omtrek van de vorm om het punt te verwijderen.

4 Selecteer het gereedschap Ankerpunt toevoegen
5 Klik op de curve om een ankerpunt toe te voegen.

Transparantie creëren
U gaat nu een tweede golf maken die de eerste gaat overlappen. De tweede golf maken we een
beetje doorzichtig om meer diepte in de afbeelding te krijgen. Transparantie kan worden toegepast
op de streek of op de vulling. De mate waarin een kleur dekkend is, wordt alfa genoemd en
uitgedrukt in een percentage. Een alfa van 100% geeft aan dat een kleur volledig dekkend
(ondoorzichtigV is, terwijl een alfa van 0% aangeeft dat een kleur helemaal transparant is.

De alfawaarde van een vulling wijzigen
1 Selecteer de vorm in de laag dark brown wave.
2 Kies Bewerken > Kopiëren.
3 Kies Invoegen > Tijdlijn > Laag en noem de nieuwe laag light

brown wave.
4 Kies Bewerken > Op plaats plakken (Ctrl/Command+Shift+V).

Met de opdracht Op plaats plakken plaatst u het gekopieerde item op exact dezelfde plaats als
waar het gekopieerd is.

5 Kies het gereedschap Selecteren en verplaats de geplakte vorm ietsje naar links of naar rechts
zodat de toppen van de golf tegen elkaar aan komen te liggen.

6 Selecteer de vulling van de vorm in de laag light brown wave.

7 Verander in het deelvenster Kleur (Venster > Kleur) de vulkleur in een iets andere bruintint
(CC6666) en wijzig de alfawaarde in 50%.



De kleurstaal onder in het deelvenster Kleur geeft een voorbeeld van de
nieuwe kleurselectie. Transparantie wordt weergegeven door het grijze
patroon achter de kleurstaal.

Opmerking: u kunt de transparantie van een vorm ook wijzigen in
Eigenschapcontrole door op het pictogram Vulkleur te klikken en de
alfawaarde aan te passen in het menu.

Kleur overnemen van een bestaand object
Als u een kleur van een omtrek of vulling exact wilt overnemen, kunt u maken van het gereed-
schap Pipet . Als u met het gereedschap Pipet op een vorm klikt, schakelt Flash direct over op
het gereedschap Emmertje of Inktfles met de geselecteerde kleur en bijbehorende eigenschappen
die u vervolgens op een ander object kunt toepassen.

1 Kies in het deelvenster Gereedschappen het gereedschap Pipet.
2 Klik op de vulling van de vorm in de laag dark brown wave.

Uw gereedschap verandert onmiddellijk in het Emmertje met de geselecteerde vulkleur.
3 Klik op de vorm in de laag light brown wave.

De vulling in de laag light brown wave komt nu exact overeen met die in de laag dark brown
wave. Maak deze stap weer ongedaan om terug te gaan naar de twee verschillend gekleurde
vormen.

Tekst maken en bewerken
Laten we tot slot enige tekst toevoegen om de illustratie te completeren. Flash kent twee
tekstopties, Klassieke tekst en het nieuwe ‘Text Layout Framework’ (TLF-tekst). U leert meer over
TLF-tekst in les 7. Voor dit project gebruiken we het eenvoudiger Klassieke tekst.

Als u tekst creëert in het werkgebied en uw project publiceert, voegt Flash automatisch alle
benodigde lettertypen toe om de tekst correct weer te geven. Dit betekent dat u zich niet hoeft af te
vragen of uw publiek wel over de vereiste lettertypen beschikt om de tekst op de bedoelde manier
te kunnen zien.

Het gereedschap Tekst gebruiken
1 Selecteer de bovenste laag.
2 Kies Invoegen > Tijdlijn > Laag en noem de nieuwe laag text.
3 Kies het gereedschap Tekst ( T ).
4 Selecteer Klassieke tekst en vervolgens Statische tekst in Eigenschapcontrole.




